
Part No. P0935737 07
23 March 2004
Multimedia Call Center

Set Up and Operation Guide



2

Multimedia Call Center Set Up and 
Operation Guide
Copyright © 2004 Nortel Networks

All rights reserved. 2004.

The information in this document is subject to change without notice. The statements, configurations, technical data, and 
recommendations in this document are believed to be accurate and reliable, but are presented without express or implied 
warranty. Users must take full responsibility for their applications of any products specified in this document. The information in 
this document is proprietary to Nortel Networks NA Inc. 

The software described in this document is furnished under a license agreement and may be used only in accordance with the 
terms of that license. The software license agreement is included in this document.

Trademarks

NORTEL NETWORKS is a trademark of Nortel Networks.

Microsoft, MS, MS-DOS, Windows, and Windows NT are registered trademarks of Microsoft Corporation.

All other trademarks and registered trademarks are the property of their respective owners.
P0935737 07



3

Contents

Chapter 1
About Multimedia Call Center . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5

Overview of Multimedia Call Center  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5

How Multimedia Call Center works for callers . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6

The Multimedia Call Center caller interface  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6

How Multimedia Call Center works for agents . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7

The Multimedia Call Center agent interface  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7

Multimedia Call Center call types  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8

PSTN voice and data calls  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8

Data only calls . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9

Requirements for using CallPilot Manager to set up Multimedia Call Center  . . . . . . . 10

How to get help  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11

Chapter 2
Setting up Multimedia Call Center . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13

Creating a user account for Multimedia Call Center  . . . . . . . . . . . . . . . . . . . . . . . . . . 13

Enabling a Software Authorization Code . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14

Setting Multimedia Call Center parameters . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15

Assigning routing to Multimedia Call Center calls . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18

How Multimedia Call Center calls work with Routing Tables . . . . . . . . . . . . . . . . . 18

Routing Multimedia Call Center calls using the CLID/DNIS table  . . . . . . . . . . . . . . . . 19

Assigning a callback route for Multimedia Call Center  . . . . . . . . . . . . . . . . . . . . . . . . 23

Configuring outdialing using PRI lines . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25

Assigning an outgoing line to a line pool . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29

Creating a Multimedia Call Center dial plan  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31

An example of a dial plan that restricts calls based on their country  . . . . . . . . . . 31

Setting the Maximum Outcalling Channels  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34

Configuring the Dialing Translation Table  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35

Chapter 3
Multimedia Call Center agents . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 37

Enabling Multimedia Call Center agents  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 37

Adding Multimedia Call Center agents to Call Center . . . . . . . . . . . . . . . . . . . . . . . . . 38

Adding more than one agent . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 41

Accepted Call Types  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 42

Installing Multimedia Call Center software on an agent’s computer  . . . . . . . . . . . . . . 43

Requirements for agents using Multimedia Call Center  . . . . . . . . . . . . . . . . . . . . 43

To install Multimedia Call Center software on an agent’s computer  . . . . . . . . . . . 43

Configuring Multimedia Call Center on a Windows 95 system . . . . . . . . . . . . . . . 44

Configuring an agent's server settings  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 45

Configuring an agent’s name . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 46

Using Follow-me browsing . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 46
Multimedia Call Center Set Up and Operation Guide



4    Contents
Chapter 4
Multimedia Call Center messages  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 47

Call setup messages . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 48

Call setup page . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 48

Preferences page  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 49

Status and error messages . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50

Multimedia Call Center unavailable message . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50

No agents logged on message . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50

Bad calling preferences message . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 51

Choose how to connect message . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 51

Session completed message  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 52

User busy message  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 52

Lines busy message . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 52

Make call failed message  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53

Preference message . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53

No answer message  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53

Connected message . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 54

Call transferred message  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 54

Web refresh message . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 54

Recording Multimedia Call Center announcements  . . . . . . . . . . . . . . . . . . . . . . . . . . 55

Downloading web pages and viewing web page lists  . . . . . . . . . . . . . . . . . . . . . . . . . 56

Customizing web pages  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 59

Overviews of downloading, customizing and uploading pages . . . . . . . . . . . . . . . 59

Uploading or deleting web pages  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 60

Creating and distributing web page lists  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 62

Chapter 5
Viewing reports, active calls and log files . . . . . . . . . . . . . . . . . . . . . . . . . . 63

Summary call report - all calls . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 63

Summary call report by skillset  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 64

Detail call report - all calls  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 65

Detail call report by skillset  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 66

Generating Multimedia Call Center reports . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67

Monitoring active calls . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 69

Viewing log files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 71

Index . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 75
P0935737 07



5

Chapter 1
About Multimedia Call Center

This guide assists a Call Center administrator with installing and configuring Multimedia Call 
Center for Nortel Networks Business Communications Manager.

This guide assumes that you are familiar with using Unified Manager and CallPilot Manager. For 
more information, refer to the Business Communications Manager Programming Operations 
Guide and the CallPilot Manager Set Up and Operations Guide.

In this document the server that Multimedia Call Center is installed on is referred to as 
“bcm.<domain>”
where:

• <domain> is the domain name of the business, for example nortelnetworks.com

• “bcm” is the host name of the server within the domain.

The server is usually called “bcm”, although any unique hostname within the domain is 
acceptable.

Overview of Multimedia Call Center
With Multimedia Call Center agents and callers can have multimedia calls that include:

• speaking over a Public Switched Telephone Network (PSTN) voice connection

• text chatting

• exchanging and viewing web pages

• viewing screen captures sent by an agent
Multimedia Call Center Set Up and Operation Guide
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P

How Multimedia Call Center works for callers
When callers on a website click a multimedia HTML link the “Call setup page” on page 48 
appears.

In the call setup page callers specify their calling preferences. Callers can access the media types 
based on their needs and resources. Callers with separate data and PSTN voice lines can have a 
PSTN voice call while they view, receive or even send web pages to agents. For information on 
Multimedia Call Center call types see “Multimedia Call Center call types” on page 8.

After a caller specifies their preferences, the multimedia call enters the Call Center. Based on the 
rules created by the Call Center Administrator, the request for an agent is sent to the appropriate 
skillset. If an agent is not immediately available, the caller can receive periodic HTML messages 
(web refresh). The Call Center Administrator programs these messages. The messages can thank 
callers for their interest, inform them that there are no agents currently available, and tell them that 
they will be connected to the first available agent.

When the call is answered by an agent, the “The Multimedia Call Center caller interface” on page 
6 appears in the caller’s web browser.

The Multimedia Call Center caller interface
The caller interface has two windows. The first window lets the caller control the progress of the 
call. The second window displays Multimedia Call Center messages and the web pages that an 
agent sends to the caller.

Opens the text chat interface Ends the call

Opens the 
preferences 
page

Displays the agent’s name
Sends the web 
page specified 
in the Send 
Page box to 
the agent
0935737 07
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How Multimedia Call Center works for agents
Depending on the call preferences the caller has requested in the call setup page, the agent can 
have a browser-only, or a voice and browser call with the caller. The agent can use follow-me 
browsing to show the caller a sequence of web pages. The agent can also push pages or screen 
captures, or have a text chat with the caller.

For a phone and browser call, the agent must answer the phone, and then the agent interface and 
browser window appears on the agent’s computer. For a browser-only call, the agent interface and 
browser window appear right away, so the agent cannot decline this type of call. The agent’s 
browser window shows the web page that the caller originally clicked to start the Multimedia Call 
Center call.

The Multimedia Call Center agent interface
The Multimedia Call Center agent interface has two windows. The first window lets an agent 
control the progress of the call. The second window displays the Multimedia Call Center web 
pages that the agent sends to a caller, or that a caller sends to them.

Shows the url of 
the web page the 
caller clicked the 
voice button on

Takes a screen 
capture of a 
web page, 
window, 
desktop, etc.

Displays in the 
second window 
the web page the 
caller clicked the 
voice button on

Opens 
Help

Shows the name 
and phone 
number the caller 
specified in the 
Call Setup page

Initiates a 
text chat 
with the 
caller

Contains a 
preset list of 
web pages

Controls whether 
web pages 
clicked by the 
agent are sent to 
the caller

Blocks 
a caller

Ends the 
browser 
session
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Multimedia Call Center call types
Callers with a PSTN voice connection and a data connection, and callers with only a data 
connection can have a multimedia session with a Multimedia Call Center agent.

PSTN voice and data calls
PSTN voice and data calls use agent-centric routing.

How an agent-centric PSTN voice and data call works

For this type of call, the caller has a separate PSTN voice and internet connection, and is not using 
their telephone.

1 The caller clicks the voice button icon on a web page.

2 The call setup page “Call setup page” on page 48 appears if the caller is not a first-time caller, 
and has cookies enabled.

3 In this example the caller enters their phone number and name. The caller can specify that their 
call is:

• by browser only (a text chat with an agent)

• by phone and browser (a PSTN voice call and text chat with an agent)

4 A request for an agent is sent over the IP network to the call center.

5 While the caller is waiting web refresh HTML pages are displayed in their browser that 
correspond to the announcement they would hear if they were on a PSTN voice call. A new 
web page can be pushed for every Call Center announcement.

6 When a Multimedia Call Center agent becomes available, the caller's phone rings.

7 The caller answers the call.

8 The Call Center routes the PSTN voice portion of the call to the Multimedia Call Center agent. 
The agent's set rings and displays “www:ss” (where ss = skillset number) to signify that the 
call is a multimedia call.

9 The agent answers the call on their set and the agent’s and the caller's audio path are 
connected, and the agent and caller's web pages are synchronized. “The Multimedia Call 
Center agent interface” on page 7 appears in the agent’s browser and the “The Multimedia 
Call Center caller interface” on page 6 appears in the caller’s browser.

10 The agent pushes appropriate web pages to the caller. The agent can have a text chat session 
with the caller.

Agent-centric call After a caller clicks voice button the Call Center phones the caller when an agent 
is available. The Call Center then connects the call to the agent.
P0935737 07
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Data only calls
For this type of call, the caller needs an Internet connection. A data only call can include text chat 
and pushed web pages.

How a data only call works

1 The caller clicks the voice button icon on a web page.

2 While the caller is waiting web refresh HTML pages are displayed in their browser that 
correspond to the announcement they would hear if they were on a PSTN voice call. A new 
web page can be pushed for every Call Center announcement along with information such as 
the number of agents in the skillset and the number of calls in the skillset. For a full list of CGI 
parameters see the Multimedia Call Center Web Developer Guide.

3 When a Multimedia Call Center agent is available “The Multimedia Call Center agent 
interface” on page 7 appears in the agent’s browser and notifies the agent that they have a call.

4 “The Multimedia Call Center caller interface” on page 6 appears in the caller’s browser.

5 The agent pushes appropriate web pages to the caller. The agent can have a text chat session 
with the caller.
Multimedia Call Center Set Up and Operation Guide
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Requirements for using CallPilot Manager to set up 
Multimedia Call Center

You set up Multimedia Call Center using CallPilot Manager, the web-based administration tool. 
You access CallPilot Manager on a web browser from a computer on your network.

System requirements

Before you use CallPilot Manager to set up Multimedia Call Center, you must have your Business 
Communications Manager system configured and Call Center installed. For how to enable a 
software authorization code, refer to “Enabling a Software Authorization Code” on page 14.

Computer requirements

The computer you use to run CallPilot Manager must have:

• WinNT or Windows workstation running P133 or later CPU (or compatible)

• 64 MB RAM, 10 MB disk space

• Minimum screen resolution of 1024 X 768 pixels

Browser requirements

To use Multimedia Call Center you must have:

• Java Runtime Environment (You can download the latest version of JRE from java.sun.com.)

• either Microsoft Internet Explorer 4.0 or later, or Netscape Communicator 4.0.5 or later, but 
not Netscape 6.0

If you use Netscape Communicator, set these parameters:

• Enable Java: on

• Cached document comparison: every time

• If you use Netscape Communicator version 4.77 and not all the Call Center settings shown in 
this guide appear in your browser, refresh the browser by clicking the View menu and clicking 
Reload. If you still cannot view the settings, upgrade your browser.

If you use Microsoft Internet Explorer, set these parameters:

• Check for newer versions: every visit to the page

• Java JIT compiler enabled: on

For more information about these settings, refer to your web browser online Help.

For more information about using CallPilot Manager or Nortel Networks Call Center, refer to the 
CallPilot Manager Set Up and Operation Guide and the Nortel Networks Call Center Set Up and 
Operation Guide.
P0935737 07
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How to get help
USA and Canada

Authorized Distributors - Technical Support

Telephone:
1-800-4NORTEL (1-800-466-7835)
If you already have a PIN Code, you can enter Express Routing Code (ERC) 196#.
If you do not yet have a PIN Code, or for general questions and first line support, you can enter 
ERC 338#.

Website:
http://www.nortelnetworks.com/support

email:
naitas@nortelnetworks.com

Presales Support (CSAN)

Telephone:
1-800-4NORTEL (1-800-466-7835)
Use Express Routing Code (ERC) 1063#

EMEA (Europe, Middle East, Africa)

Technical Support

Telephone:
00800 800 89009

Fax:
44-191-555-7980

email:
emeahelp@nortelnetworks.com

CALA (Caribbean & Latin America)

Technical Support

Telephone:
1-954-858-7777

email:
csrmgmt@nortelnetworks.com

APAC (Asia Pacific)

Technical Support

Telephone:
+61 388664627

Fax:
+61 388664644

email:
asia_support@nortelnetworks.com
Multimedia Call Center Set Up and Operation Guide
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Chapter 2
Setting up Multimedia Call Center

Setting up Multimedia Call Center involves:

• Creating a user account for Multimedia Call Center

• Enabling a Software Authorization Code

• Setting Multimedia Call Center parameters

• Assigning routing to Multimedia Call Center calls

• How Multimedia Call Center calls work with Routing Tables

• Routing Multimedia Call Center calls using the CLID/DNIS table

• Assigning a callback route for Multimedia Call Center

• Configuring outdialing using PRI lines

• Assigning an outgoing line to a line pool

• Creating a Multimedia Call Center dial plan

• An example of a dial plan that restricts calls based on their country

• Setting the Maximum Outcalling Channels

• Configuring the Dialing Translation Table

Creating a user account for Multimedia Call Center
You have the option of creating user accounts that let several people have access to Multimedia 
Call Center settings. A user account lets users access their information, but not anyone else’s.

For example, if you have a Web Developer who creates custom web pages for your business, you 
can create a user account for them. This gives them their own user ID and password that gives 
them access to certain tasks, for example, downloading and uploading web pages, and viewing 
web page lists. Another example is ABC Computers has weekly specials and wants to update their 
information weekly. You can create a user account for ABC Computers that lets anyone who has 
the user ID update their web pages.

For information on creating user accounts, refer to the Business Communications Manager 
Programming Operations Guide.
Multimedia Call Center Set Up and Operation Guide
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Enabling a Software Authorization Code
You enable Multimedia Call Center by enabling the Multimedia Call Center software 
authorization code on the Business Communications Manager Unified Manager. Before you 
enable Multimedia Call Center you must have Call Center installed on your system.

To enable the Multimedia Call Center software authorization code

1 To log on to Unified Manager, point your web browser to the URL
https://bcm.<domain>
where <domain> is the domain name of Business Communications Manager system.
The Business Communications Manager Unified Manager screen appears.

2 Click the Configure button.
The Login screen appears.

3 In the User ID box type your user ID.

4 In the Password box type your password.

5 Click the Login button.
The Unified Manager screen appears.

6 Click the System key.

7 Click the Licensing heading.
The Licensing Setting screen appears.

8 On the Configuration menu click Add a Keycode.
The Applied Keycodes screen appears.

9 In the Keycode box type the number of the keycode you want to enable.

10 Click the Save button.

11 Do not log off Business Communications Manager.
Go to “Setting Multimedia Call Center parameters” on page 15.
P0935737 07
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Setting Multimedia Call Center parameters
You must set the system name, public host name, signature, and how long the log files are kept.

To set Multimedia Call Center parameters

1 Log on to Unified Manager.

2 Click the Services key.

3 Click the Multimedia Call Center heading.
The Summary screen appears.

4 On the Tools menu click Multimedia Call Center Admin.
The Enter Network Password dialog box appears.

5 In the User Name box type your user name.

6 In the Password box type your password.
Multimedia Call Center Set Up and Operation Guide
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7 Click the OK button.
The System Administration page appears.

8 Under the Other Administrative Functions heading, click the View Params button.
The System Parameters page appears.

9 In the System name box type the host name of your Business Communications system.

10 In the Public hostname box type the appropriate public host name for your system. Ask your 
network administrator how your system is set up.

• If you have no firewall, or you use Business Communications Manager as the firewall, 
enter the external IP address of your Business Communications Manager system.

•  If you use a dedicated firewall/proxy server, enter its external IP address.
P0935737 07
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11 In the Signature box enter the signature you want to use. The signature is a tag that appears on 
Unified Manager pages for Multimedia Call Center. The default signature is Nortel Networks 
Multimedia Call Center. You can change the signature.

12 From the Keep log files for list box, select how long you want to keep log files. The default is 
20 days.

13 Click the Update Params button.
A message appears that the parameters are updated.

14 Do not log off Business Communications Manager.
Go to “Assigning routing to Multimedia Call Center calls” on page 18.
Multimedia Call Center Set Up and Operation Guide
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Assigning routing to Multimedia Call Center calls
You must assign how Multimedia Call Center calls are routed. The standard method of assigning 
call routing is to specify the initial skillset in the web link that is used to initiate the call. See the 
Multimedia Call Center Web Developer Guide for details. You specify the skillsets to be used to 
the web developer, who includes this information on the customized web pages for your company.

If you use Professional Call Center, you can also use the callback number information for a 
Multimedia Call Center Call, to move the call to another skillset or change the call’s priority 
within the skillset. The callback number is processed by the CLID column.

How Multimedia Call Center calls work with Routing Tables
When you set up your Call Center, you create Day and Night Routing Tables for each skillset. To 
route Multimedia Call Center calls effectively, you must understand how routing steps affect 
Multimedia Call Center calls. For example, you can set up the Night Routing Table so that when 
your Call Center is closed, Multimedia Call Center calls will transfer to a mailbox or another 
number.

Before a Multimedia Call Center call is connected to an agent, these Intelligent Overflow actions 
disconnect the call in the caller’s browser and display a message to the caller:

• transfer to Skillset mailbox

• transfer to external or internal DN

• transfer to Automated Attendant

• transfer to Operator

Before a Multimedia Call Center call is connected to an agent, these actions route the call as 
expected:

• Overflow to other skillsets

• Move to another skillset

• Change priority of call

For information about setting up Day and Night Routing Tables, refer to the Nortel Networks Call 
Center Set Up and Operation Guide.

Note: The skillset defined in the HTML tag is used unless there is an overriding rule in 
the CLID/DNIS table.
P0935737 07
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Routing Multimedia Call Center calls using the CLID/DNIS 
table

If you do not want to use a CLID/DNIS table, continue with “Assigning a callback route for 
Multimedia Call Center” on page 23.

1 On the Unified Manager, click the Services key.

2 Click the Voice Mail heading.
The Summary screen appears.

3 On the Tools menu click CallPilot Manager Admin.
The Administration Login screen appears.

4 In the Password box type your system administrator password.
Multimedia Call Center Set Up and Operation Guide
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5 Click the Submit button.
The CallPilot Manager screen appears.

6 Click the Call Center heading.

7 Click the CLID/DNIS Routing Table link.
The Intelligent CLID/DNIS Routing page appears.
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8 Click the Insert link to assign how Multimedia Call Center calls are routed.
The CLID/DNIS Setup page appears.

9 Select how you want Multimedia Call Center calls to be routed:
• If you want Intelligent CLID/DNIS routing to apply to Multimedia Call Center calls, 

select the Multimedia Calls check box and do not enter information in the Line or DNIS 
boxes.

• Select the action and call priority.

• Click the Submit button.
The Intelligent CLID/DNIS Routing page appears.
The routing rule you created appears in this table.

The CLID/DNIS Routing table below shows three examples of Multimedia Call Center 
rules.
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• In the first Multimedia Call Center rule, Multimedia Call Center calls with a CLID or ANI 
of 4033 are routed to skillset 2 and given a priority of 18.

• In the second Multimedia Call Center rule, Multimedia Call Center calls with a CLID or 
ANI of 4053 change to a priority 8.

• In the third Multimedia Call Center rule, Multimedia Call Center calls that do not match 
the other rules shown in this table are routed to skillset 2 and given a priority of 4.
You can use the wildcard character ( * ) for Multimedia Call Center rules. For example, if 
you want to program all Multimedia Call Center calls from a specific area code such as 
403 to have a high priority and go to skillset 1, select Multimedia Calls, enter 403* and 
select priority 1 and skillset 1.

10 Do not log off CallPilot Manager.
Go to “Assigning a callback route for Multimedia Call Center” on page 23 and assign a 
callback route.
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Assigning a callback route for Multimedia Call Center
A callback route must be set up for Call Center to connect to the caller’s phone. You can program 
the callback route on a per skillset basis by programming the skillset mailbox, or on a system-wide 
basis by using the system administration mailbox. The callback route is determined as follows:

• If you program a skillset to have a callback route associated with it, Multimedia Call Center 
uses the callback route that you have programmed.

• If you do not program a skillset to have a callback route, but you program the system 
administration mailbox to have a callback route associated with it, Multimedia Call Center 
uses the callback route that you have programmed.

• If you do not program a skillset or the system administrator mailbox to have a callback route, 
Multimedia Call Center uses Pool A.

To assign a callback route for a skillset or the System Administrator mailbox

1 On CallPilot Manager, click the Mailbox Administration heading.
The Mailbox List page appears.

2 Click the Change link for the mailbox that you want to assign a callback route to, either the 
system administrator mailbox or the skillset mailbox.

3 Select an Outdial Type.
If you are not sure of which outdial type to select, ask your System Administrator.
Multimedia Call Center Set Up and Operation Guide



24    Chapter 2  Setting up Multimedia Call Center
• If you select Pool, enter a number between 1 (for Pool A) and 15 (for Pool O). Make sure 
that this Pool has lines assigned to it. Refer to “Assigning an outgoing line to a line pool” 
on page 29.

• If your system uses PRI lines for outdialing, select Route as the outdial type. Ask your 
System Administrator what the PRI routing code is.

If you use PRI lines, you must also:

a make sure the routing table is set up correctly.
Refer to “Configuring outdialing using PRI lines” on page 25.

b create whatever calling restrictions you need, including the routing code.
Refer to “Creating a Multimedia Call Center dial plan” on page 31.

c configure the Dialing Translation Table.
Refer to “Configuring the Dialing Translation Table” on page 35.

4 Do not log off.
If you use PRI lines, go to “Assigning an outgoing line to a line pool” on page 29.
If you use a line pool, go to “Configuring outdialing using PRI lines” on page 25.
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Configuring outdialing using PRI lines
If you use Primary Rate Interface (PRI) lines, you must configure the outdialing for your Call 
Center. If you don’t, go to “Assigning an outgoing line to a line pool” on page 29.

1 On Unified Manager, click the Resources key and click the Media Bay Modules key.

2 Click the Bus key for the module number of your PRI Media Bay Module.
Ask your System Administrator or Installer for the module number of your PRI Media Bay 
Module. For information about dipswitch configuration refer to the Business Communications 
Manager Installation and Maintenance Guide.

3 Click the Modules on Bus key and click the Module 1 heading.

4 Record the Low line/loop assignment that is shown. You will need this for step 7.
Make sure that the protocol is set to be compatible with your PRI service provider.

5 On the Configuration menu click Disable, and then click Enable.

6 Click the Services key, click the Telephony Services key, click the Lines key, click the 
Physical lines key, click the All physical lines key and click the key for the Low line/loop 
number that you recorded in step 4, (in this example Line 211).
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7 Click the Trunk/line data heading.
Verify that the line type is a PRI Pool.
Record the Pool letter. You need this for the “Use Pool” value in the routing table.

8 Scroll down to the Call routing key and click it. Click the Routes heading and click the Add 
button.
The BCM Dialog Box appears.

9 In the Route box, type a route number. In this example route 002 is shown.

10 Click the Save button.
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11 Click the Routes key and select Route you created.
From the Use pool list box select Pool PRI-A.
From the DN type list box select Public.

12 To configure destination codes, click the Destination codes heading and click the Add button.
The BCM Dialog box appears.

13 In the Destination code box type the destination code you want to use.
In this example 8A is shown. (A represents any). This means that any dialed number that starts 
with 8 uses PRI-A, that is, routing code 8 uses Pool PRI-A.

14 Click the Destination Codes key and click the key for the destination code you created. Click 
the Schedules key and click the Normal heading.

15 In the Use route box change the route number to 002.
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16 Configure the absorb length. From the Absorb length list box select an absorb length.
Set the absorb length so that the routing code is not actually dialed.
In this example, 8A is the destination code, with an absorb length of 1. This means that the 8 is 
absorbed, and only the digits after it are dialed out on the PRI line.

17 Now configure the public DN length. This is the length of digits after the prefix that agents can 
dial. Click the General settings key, click the Dialing plan key, click the Public Network 
key, click the Public DN lengths key and from the list select the prefix that selects PRI for 
outdialing.
In this example the prefix is the number 8 and the DN length is 10 digits.

18 Log off Unified Manager.
Do not Assign an outgoing line to a line pool.
Go to “Creating a Multimedia Call Center dial plan” on page 31.
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Assigning an outgoing line to a line pool
You must assign an outgoing line to a line pool so that Multimedia Call Center accepts callback 
calls. In this example, a line is assigned to Pool A. You do not need to do this procedure if you use 
PRI lines.

To assign an outgoing line to a line pool

1 On a telset, enter Feature 985 to display the Voicemail DN.

2 On the Unified Manager screen, click the Services key.

3 Click the Telephony Services key.

4 Click the System DNs key.

5 Click the All System DNs key.

6 Click the key for the Voicemail DN.

7 Click the Line access heading.

8 From the Prime Line list box select Pool A.

9 Click the General Settings key.

10 Click the Access Codes key.

11 Click the Line pool codes key.

12 Click the Pool A heading.
The Pool A screen appears.
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13 Make sure that Access code is set to 9.

14 Click the Lines key and click the key for the number of the line you want to use for outdialing.

15 Click the Trunk/line data heading.

16 In the Line type list box make sure that Pool A is selected.
Do not log off. Go to “Creating a Multimedia Call Center dial plan” on page 31.
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Creating a Multimedia Call Center dial plan
You can create a callback dial plan that restricts Multimedia Call Center from calling certain 
numbers. When you create a dial plan you add restrictions to the DNs that Business 
Communications Manager uses for callback. This limits where MMCC will accept calls from, for 
example you can create a restriction that limits calls to local calls from your service area.

You can add restrictions to skillset and the Voicemail DNs. You can display DNs by entering 
Feature 985 on a set.

An example of a dial plan that restricts calls based on their country
Bridgestone computers sells computers in the United States and Canada, and has different 
information for prices and shipping depending on the country.

The Call Center administrator sets up restrictions for the U.S. and Canada skillsets. When a caller 
in the U.S. clicks the HTML link and enters their phone number, the restrictions for the US skillset 
recognize the caller’s U.S. area code, and calls back telephone numbers within the US.

To add a restriction to the Business Communications Manager system

1 Click the Services key.

2 Click the Telephony Services key.

3 Click the Restriction filters key.

4 Click the key for the filter you want to add a restriction to.

Note: If you add a restriction to the Voicemail DN you also restrict all outcalling calls, 
including external transfers from CCR Trees, Off-premise Message Notification and 
Outbound Transfers.
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5 Right-click the Restrictions heading and click Add.
The Add Restrictions dialog box appears.

6 In the Digits box, type the digits you want to restrict.
If your outdial type is Route, enter the routing code before you add the digits you want to 
restrict. For example, if your routing code is 8 and you want to restrict numbers that begin with 
403, enter 8403.

7 Click the Save button.

8 Click the Services key.

9 Click the Telephony Services key.

10 Click the System DNs key.

11 Click the All system DNs key.

12 Click the key for the Voice Mail DN or the DN of the skillset you want to add a restriction to.

13 Click the Restrictions key.

14 Click the Set Restrictions key.

15 Click the Schedules key.
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16 Click the Normal heading.

17 In the Use filter box type the filter number. The default restriction filter is 00.
For more information on programming dialing plans and filters refer to the “Configuring 
Business Communications Manager Services" section of the Business Communications 
Manager Programming Operations Guide.

18 Do not log off. Go to “Setting the Maximum Outcalling Channels” on page 34.
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Setting the Maximum Outcalling Channels
When you install Multimedia Call Center on your system, set the Maximum Outcalling Channels 
to a value higher than 1. The default number of voice channels assigned for outcalling is 1. Also, to 
ensure that the Outcalling Channels do not consume all the available voice channels, set the 
Outcalling Channels to a number lower than the minimum number of voice ports. For information 
on how to change the minimum number of voice ports refer to the MSC Configuration chapter of 
the Business Communications Manager Programming Operations Guide.

If you do not set the Maximum Outcalling Channels to higher than one, callers see the “Lines busy 
message” on page 52.

1 On CallPilot Manager, click the Configuration heading.

2 Click the System Properties link.
The System Properties page appears.

3 In the Max Outcalling Channels box type a value higher than 1.

4 Click the Submit button.

5 You can log off CallPilot Manager and return to Unified Manager. Do not log off Unified 
Manager. Go to “Configuring the Dialing Translation Table” on page 35.
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Configuring the Dialing Translation Table
If your outdialing type is route, configure the Dialing Translation Table to add your routing prefix 
to the callback numbers.

1 Click the Services key and click the Voice Mail heading.
The CallPilot Manager screen appears.

2 On the Tools menu click Call Pilot Manager Admin.
The CallPilot Manager Administration Login page appears.

3 In the Password box enter the CallPilot Manager password and click the Submit button.

4 Set up Dialing Translation Tables so that when Call Center dials a callback number, it first 
dials the routing code to access the PRI pool. Call Center can use callers’ phone numbers as 
entered.
Click the Configuration heading and click the Dialing Translation Table link.
The Dialing Translation Table page appears.
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5 Click the Add button.
The Dialing Translation Setup page appears.

6 In the Input Value box enter the number you want to translate.
In the Output Value box enter what you want to translate the number to.
In this example, the number 4 is translated to 84. This means that when a Multimedia Call 
Center callers enters a number that starts with 4, Call Center automatically adds the prefix 8.

7 Click the Submit button.
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Setting up Multimedia Call Center agents involves:

• Enabling Multimedia Call Center agents

• Adding Multimedia Call Center agents to Call Center

• Adding more than one agent

• Installing Multimedia Call Center software on an agent’s computer

• Configuring an agent's server settings

• Configuring an agent’s name

Enabling Multimedia Call Center agents
With the Nortel Networks Multimedia Call Center Software Authorization Code you can enable 
all your Call Center agents as Multimedia Call Center agents. If you need more agents, you can 
purchase additional agent Software Authorization Codes that enable an additional 1, 4, 8, 16 or 32 
agents.

To enable Multimedia Call Center agents

1 Follow the steps in “Enabling a Software Authorization Code” on page 14 to apply the Call 
Center Agent Software Authorization Code for the number of agents you want to enable.

2 Do not log off Business Communications Manager.
Follow the steps in “Adding Multimedia Call Center agents to Call Center” on page 38 to add 
Multimedia Call Center agents to Call Center.
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Adding Multimedia Call Center agents to Call Center
1 On the Unified Manager, click the Services key.

2 Click the Voice Mail heading.
The Voice Mail screen appears.

3 On the Tools menu click CallPilot Manager Admin.
The Administration Login screen appears.

4 In the Password box type the system administrator password.
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5 Click the Submit button.
The CallPilot Manager Main page appears.

6 Click the Call Center heading.

7 Click the Agent List link.
The Agent List page appears.

8 Add a new Multimedia Call Center agent to the Call Center or change a Call Center agent’s 
settings:
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• If the agent has been added to Call Center and you want to enable them as a Multimedia 
Call Center agent, click the Change link for the agent.
The Change Agent page appears.

• If the agent has not been added to Call Center and you want to add a new agent as a 
Multimedia Call Center agent, click the Add button.
The Add Agent page appears.

9 From the Accepted Call Types list box select whether the agent takes Multimedia calls or 
Call Center and Multimedia calls. See “Accepted Call Types” on page 42 more information.

• Select Multimedia if you want the agent to take multimedia calls.

• Select Both if you want the agent to take multimedia and Call Center calls.

10 Click the Submit button.
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Adding more than one agent
You can save time by adding more than one agent at a time. When you add multiple agents, the 
agents have the default agent name and parameters.

To add more than one agent

1 Start CallPilot Manager.

2 Click the Call Center heading.

3 Click the Add Many Agents link.
The Add Many Agents page appears.

4 In the From box type the lowest agent ID number of the agents you want to create.

5 In the To box type the highest agent ID number of the agents you want to create.
The Agent ID numbers you enter must be between 1 and 250.

6 Select the Supervisor check box if you want the agents to have Supervisor status.

7 Select the Automatic Answer check box if you want calls to be force-delivered to the agents.

8 From the Missed Call Option list box select Make Not Ready (Return to Skillset) or 
Automatic Logout.

9 From the Accepted Call Types list box select whether the agent takes multimedia calls or Call 
Center and multimedia calls. See “Accepted Call Types” on page 42 more information.

• Select Multimedia if you want the agent to take multimedia calls.

• Select Both if you want the agent to take multimedia and Call Center calls.

10 Click the Submit button.
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Accepted Call Types
The Accepted Call Types parameter determines what type of calls are routed to an agent. This 
parameter also determines whether an agent must log onto a telephone, Multimedia Call Center or 
both.

This table shows what capabilities agents have depending on their Accepted Call Types and what 
they are logged on to.

Note: Any agents who have an agent ID number that is between the numbers you enter 
in the From and To boxes are not changed. These agents are not included in the number 
of agents added.

Type of calls 
you can 
receive

Are you logged 
onto a telephone?

Are you logged 
onto Multimedia 

Call Center?

Can you have voice 
calls?

Can you have phone 
and browser 

Multimedia Call 
Center calls?

Can you have 
browser only 

Multimedia Call 
Center calls?

Voice
No Not permitted No --- ---

YES Not permitted YES --- ---

Multimedia 
Call Center

No No --- No No

No YES --- No YES

YES No --- No No

YES YES --- YES YES

Both

No No No No No

No YES No No No

YES No No No No

YES YES YES YES YES
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Installing Multimedia Call Center software on an agent’s 
computer

You must install and configure the Multimedia Call Center software on the computer of each 
Multimedia Call Center agent.

Requirements for agents using Multimedia Call Center
To use Multimedia Call Center, agents must have:

• Internet Explorer 5.5 with SP 2, or a later version of Internet Explorer

• any of these operating systems: Windows 95B, Windows 98SE, Windows NT4 SP5 (or later), 
Windows 2000, Windows ME or Windows XP

• a Pentium II processor at 233MHz, minimum (Pentium III at 500MHz or higher 
recommended)

• 64 MB of RAM, minimum (128 MB or higher recommended)

•  30 MB of free hard drive space

• Java runtime version 1.4.0 or later (available from java.sun.com)

• a network card and an Internet connection

To install Multimedia Call Center software on an agent’s computer
1 On the agent’s computer, point the web browser to the URL

https://bcm.<domain>:
where <domain> is the domain name of Business Communications Manager system.
The Business Communications Manager Unified Manager screen appears.

2 Click the Install Clients button.
The Download Client Applications page appears.

3 In the left frame, under the Call Center Applications heading, click the Multimedia Call 
Center link.
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4 Click the http://java.sun.com link and download Java runtime version 1.4.0 or newer.
The File Download dialog box appears.

5 Click the Save this program to disk option and then click the OK button.
The Save As dialog box appears.

6 Navigate to where you want to download the file to and click the Save button.

7 Locate the downloaded file and double-click the icon to install Java Runtime Environment.

8 On the Download Desktop Applications page, click the Download Multimedia Call Center 
button.
The File Download dialog box appears.

9 Select the option to save the program or run it, and then click the OK button.
The Save As dialog box appears.

10 Navigate to where you want to download the file to and click the Save button.

11 Locate the downloaded file and double-click it to unzip it and install the Agent Notification 
software on the agent’s computer. We recommend you install the software in C:\Program 
Files\Nortel Networks\Voice Button Agent Notification.

Configuring Multimedia Call Center on a Windows 95 system
Download this patch for each Multimedia Call Center agent who uses the Windows 95 operating 
system on their computer. This patch upgrades the agent’s WinSock32 to version 4.10.1656.

To download the patch

1 On the agent’s computer point the web browser to the Microsoft website at
http://www.microsoft.com

2 Search for Windows Socket 2 Update.

3 Download the patch and follow the installation instructions.

Note: You must install Java Runtime Environment (JRE) before you download 
Multimedia Call Center to the agent’s computer.
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Configuring an agent's server settings

To configure an agent’s server settings

1 To start the Multimedia Call Center software on the agent’s computer, click the Start button, 
point to Programs, point to Nortel Networks, point to Multimedia Call Center and click 
Agent Notification.
The Agent Login/Logout dialog box appears.

2 On the Options menu click Server Setup.
The Server Setup dialog box appears.

3 In the Server IP box type the IP address or FQDN of the Business Communications Manager.

4 Click the OK button.
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Configuring an agent’s name
Either you or the agent can enter the agent name that is displayed to callers.

1 To start the Multimedia Call Center software on the agent’s computer, click the Start button, 
point to Programs, point to Nortel Networks, point to Multimedia Call Center and click 
Agent Notification.
The Agent Login/Logout dialog box appears.

2 On the Options menu click Agent Name.
The Agent Preferences dialog box appears.

3 In the Agent Name box type the agent name that will be displayed to callers.

4 Click the OK button.

Using Follow-me browsing
Follow-me browsing does not work with embedded Flash animations. If an agents clicks a Flash 
button, the image that is sent to the agent is not displayed to the caller.

Tell agents that if the page they are sending to the caller contains Flash animations, they must tell 
the caller to display the page by, for example, clicking the Next button, or telling them what to 
click on the page to display the next page.
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Multimedia Call Center messages are messages that are sent from a business’ web site to callers, 
who are customers, contacts, or surfers that have contacted the business.

These messages assist customers in making contact with the business, give customers choices in 
the type of media they use to contact the business, and provide updates about the progress of their 
call.

You or your web developer can:

• customize the default Multimedia Call Center message templates

• create lists of web pages that Multimedia Call Center agents push to callers

• create interfaces, which are sets of web pages specific to topics, such as sales and service 
department, or languages, such as French, Spanish and German

For information about:

• default Multimedia Call Center messages see:

• “Call setup messages” on page 48

• “Status and error messages” on page 50

• downloading message templates see “Downloading web pages and viewing web page lists” on 
page 56

• customizing messages see “Customizing web pages” on page 59

• uploading web pages see “Uploading or deleting web pages” on page 60

• creating and distributing lists of web pages see “Creating and distributing web page lists” on 
page 62

• creating custom interfaces refer to the Multimedia Call Center Web Developer Guide
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Call setup messages
“Call setup page” on page 48 shows the interface for initiating a multimedia call.

“Preferences page” on page 49 shows the interface callers can change their preferences from.

Call setup page
Callers see this form when they click the Multimedia Call Center icon on a web page.

CallSetup.html
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Preferences page
Callers see this HTML form if they click the preferences link. Callers can click the preferences 
link from the applet interface or a web page.

Preferences.html
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Status and error messages
During a call, a caller can see one or more of these status and error messages. Multimedia Call 
Center displays these messages by creating an instance of the HTML template file called 
MSG.html.

Multimedia Call Center unavailable message
Callers see this message if they click the voice button while Business Communications Manager is 
not operational.

MSG.html

No agents logged on message
Callers see this message if there are no Multimedia Call Center agents logged on.

MSG.html
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Bad calling preferences message
Callers see this message if the phone number they enter in the call setup page is improperly 
formatted, or if Multimedia Call Center does not provide service to their calling area.

MSG.html

Choose how to connect message
Callers see this message if they do not specify their connection preferences in the call setup page.

MSG.html
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Session completed message
Callers see this message after they click the Hangup button on the caller interface.

MSG.html

User busy message
Callers see this message if their call cannot be completed because their phone line is busy.

MSG.html

Lines busy message
Callers see this message if their call cannot be completed because Business Communications 
Manager has no available phone lines. Set the Maximum Outcalling Channels to more than one so 
that phone lines are available. For more information refer to “How Multimedia Call Center calls 
work with Routing Tables” on page 18.

MSG.html
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Make call failed message
Callers see this message if their call cannot be connected because there is a problem with the 
Multimedia Call Center server.

MSG.html

Preference message
Callers see this message after they enter their calling preferences in the preferences page.

MSG.html

No answer message
Callers see this message if they do not answer their phone.

MSG.html
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Connected message
Callers see this message when they connect to an agent.

MSG.html

Call transferred message
Callers see this message when Multimedia Call Center or an agent transfers the voice call.

MSG.html

Web refresh message
Callers see this message while they are waiting for a Multimedia Call Center agent to become 
available. You or your web developer can create variations of this message to assure callers that 
their call is important, and all agents are still busy.

REFRESH.html
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Recording Multimedia Call Center announcements
When you record announcements for Multimedia Call Center, record announcements that callers 
hear while they are waiting for agents.

You record Call Center messages using CallPilot Manager. For information on recording Call 
Center announcements see the Call Center Set Up and Operation Guide.
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Downloading web pages and viewing web page lists
If you want to customize a Multimedia Call Center page, download it to your computer, customize 
it, and then upload it to Business Communications Manager. You can also view the lists of 
Multimedia Call Center files that are on your system.

To download web pages or view lists of pages

1 Point your web browser to the URL
https://bcm.<domain>:
where <domain> is the domain name of Business Communications Manager.
The Business Communications Manager Unified Manager screen appears.

2 Click the Configure button.
The Login screen appears.

3 In the User ID box type your user ID.

4 In the Password box type your password.

5 Click the Login button.
The Unified Manager screen appears.

6 Click the Services key.

7 Click the Multimedia Call Center heading.

8 On the Tools menu click Multimedia Call Center Admin.
The Enter Network Password dialog box appears.
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9 In the User Name box type your user name.

10 In the Password box type your password.

11 Click the OK button.
The System Administration page appears.

12 Under the Customize heading, click the View/Download Files button to generate a list of the 
files.
The list appears in a new browser page. The default sub-folder contains the set of default web 
page templates and text substitutions. Other sub-folders are created when you upload 
customized web pages.
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13 To view a list of web pages, click the link for the list you want to view
or
to download the default web pages if you want to customize Multimedia Call Center web 
pages, click the default link. In this example, we clicked the default link.
The list of default Multimedia Call Center web pages appears.

14 To download a file, right-click the link, click Save As and save the file to your computer.
You can change the filename if you want to.
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Customizing web pages
You or your web developer can customize web pages and upload them to Business 
Communications Manager. You can customize the default Multimedia Call Center web pages or 
create your own.

To customize web pages

1 Download the web page or web page list you want to customize to your computer. Refer to 
“Downloading web pages and viewing web page lists” on page 56.

2 Customize the file or list of files.

3 Upload the customized files to Business Communications Manager using the procedure in 
“Uploading or deleting web pages” on page 60.

Overviews of downloading, customizing and uploading pages

An overview of customizing an MSG.html file for the ABC Computer Company

1 Download the MSG.html template from Business Communications Manager to your desktop. 
Refer to “Downloading web pages and viewing web page lists” on page 56.

2 Customize the MSG.html file.

3 Save the new customized file in your local directory. Save the new file with a new name, such 
as abc_msg.html.

4 Log on to Business Communications Manager using the ABC Computer Company User ID 
and password. For more information about user accounts see “Creating a user account for 
Multimedia Call Center” on page 13.

5 Upload the file. Refer to “Uploading or deleting web pages” on page 60.

An overview of uploading Spanish-language status and error messages

1 Download the msg.html and msg.txt template files from Business Communications Manager 
to your desktop and customize them. Refer to “Downloading web pages and viewing web page 
lists” on page 56.

2 Upload the files using the procedure in “Uploading or deleting web pages” on page 60:

• In the Interface name text box type spanish.

• In the Remote file name text box type msg.html.

• In the Local file text box type the local path to the customized msg.html file, or use the 
Browse button to help you locate the file on your desktop.

• Click the Add File button.

Note: Do not directly edit web pages.

Do not change the location of the Multimedia Call Center default files on Business 
Communications Manager.
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Uploading or deleting web pages
After you customize Multimedia Call Center web pages, use this procedure to upload them to 
Business Communications Manager. You can also use this procedure to delete any customized 
files that are outdated, misnamed, or misfiled.

To upload or delete customized files

1 Point your web browser to the URL
https://bcm.<domain>:
where <domain> is the domain name of Business Communications Manager.
The Business Communications Manager Unified Manager screen appears.

2 Click the Configure button.
The Login screen appears.

3 In the User ID box type your user ID.

4 In the Password box type your password.

5 Click the Login button.
The Unified Manager screen appears.

6 Click the Services key.

7 Click the Multimedia Call Center heading.

8 On the Tools menu click Multimedia Call Center Admin.
The Enter Network Password dialog box appears.

9 In the User Name box type your user name.

10 In the Password box type your password.

11 Click the OK button.
The System Administration page appears.
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12 To upload files:

a In the Interface name box type the folder name you want to save the file in. Either enter 
the name of an existing folder, or type a new name. If you type a new name, a new folder is 
created. The folder name is used as the interface parameter in links from your web site to 
Multimedia Call Center. For more information on creating web links see chapter 3, 
“Integrating Multimedia Call Center with a website” in the Multimedia Call Center Web 
Developer Guide.

b In the Remote File name box enter the name of the file, for example, 
LaunchMonitor.html.

c Click the Browse button and browse to the location of the file you customized, for 
example, ABCLaunch.html, or enter the path name of the file in the Local file box.

d Click the Add File button.

To delete files:

a In the Interface name box type the folder name you want to delete the file from.

b In the Remote File name box enter the name of the file, for example, 
LaunchMonitor.html.

c Click the Delete File button.

To upload graphics such as .gifs or .jpegs, or other media such as .wav files or animated gifs:

a In the Interface name box type media.

b In the Remote file name box enter the name that you want to save the file as.

c Click the Browse button and browse to the location of the file, or enter the path name of 
the file in the Local File box.

d Press the Add File button and check in the file list that the file is uploaded.

When you include the uploaded media on a web page, use the relative path “/ivb-media” to refer to 
uploaded media files. For example, if you upload the file “logo.jpg” to the media interface, in a 
custom HTML files reference the file by including a tag such as
<IMG SRC="/ivb-media/logo.jpg" ...>.
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Creating and distributing web page lists
You or your web developer can create bookmarked lists of web pages that agents can push to 
callers.

After you create a web page list, export it in a shared directory on your network and notify the 
Multimedia Call Center agents to import the list.

To create a list of web pages

1 In your browser, create a folder for the new list of web pages. Create a folder name that is easy 
to identify.

2 Browse to the pages you want to bookmark.

3 Bookmark each page, and save each bookmark in the folder you created.

4 To start the Import/Export Wizard, on the File menu click Import and Export.

5 Save the folder you created to a network drive.

6 Send an email to the agents that they should import the new folder into their Favorites. In your 
email tell the Multimedia Call Center agents where the web page list is located on the network. 
Be sure to include the location of the folder in your message. You can set up an address list of 
agents so you can notify all the agents with one email.

Whenever you create or update a web page list, notify the agents to copy the list to their computer.

Note: You must use Internet Explorer for the web page lists you create and distribute. 
Netscape is not supported.
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Viewing reports, active calls and log files

There are four reports you can generate that show the Multimedia Call Center activity on Business 
Communications Manager:

Summary call report - all calls
The Summary call report for all calls shows:

• total number of Multimedia Call Center calls completed

• total number of text calls completed 

• total number of calls ("transactions")

• total time of all calls

• average time per call

Report Contains

Summary call report - all 
calls

a summary of call statistics over a specified time

Summary call report by 
skillset

a summary of call statistics for all skillsets over a specified time

Detail call report - all calls a detailed list of all calls made over a specified time

Detail call report by skillset a detailed list of all calls made by all skillsets over a specified time

Note: Active calls and calls waiting in skillsets are not included in reports.

To see all calls, including Multimedia Call Center calls waiting in skillsets, press
Feature 909 on a Business Communications Series terminal.

Browser Only calls are not shown when you use Feature 909.
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An example of a Summary call report for all calls

Summary call report by skillset
The Summary call report by skillset shows the information in the Summary call report for all calls, 
and the information by skillset.

An example of a Summary call report by skillset
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Detail call report - all calls
The Detail call report for all calls shows the information in the Summary call report for all calls, 
and a detailed list of each call completed during the time period of the report. For each call, the 
report shows:

• Time - the time and date the call started

• Duration - the duration of the call

• Request from - the caller's phone number

• Received by - the agent's phone number

• Group - the skillset

An example of a Detail call report for all calls
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Detail call report by skillset
The Detail call report by skillset shows the information in the Detail call report for all calls and 
summarizes the information by skillset.

Example of a Detail call report by skillset
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Generating Multimedia Call Center reports

To generate a Multimedia Call Center report

1 Point your web browser to the URL
https://bcm.<domain>:
where <domain> is the domain name of Business Communications Manager.
The Business Communications Manager Unified Manager screen appears.

2 Click the Configure button.
The Login screen appears.

3 In the User ID box type your user ID.

4 In the Password box type your password.

5 Click the Login button.
The Unified Manager screen appears.

6 Click the Services key.

7 Click the Multimedia Call Center heading.
The Summary screen appears.

Note: Generating reports can put an additional load on Business Communications 
Manager. Avoid generating reports during periods of peak activity. If possible, generate 
reports after hours.
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8 On the Tools menu click Multimedia Call Center Admin.
The Enter Network Password dialog box appears.

9 In the User Name box type your user name.

10 In the Password box type your password.

11 Click the OK button.
The System Administration page appears.

12 Under the Reporting heading, select the type of report you want to generate:

• Summary Call Report - All Calls

• Detail Call Report - All Calls

• Summary Call Report By Skillset

• Detail Call Report By Skillset

13 From the View Report list box, select the time period for the report:

• today - includes calls completed on the current day up to the time the report is generated

• current reporting period - includes calls made since the last time the reporting period 
was archived

14 Press the View Report button to generate the report.

15 If you want to archive the file used to generate the reports, click the Archive Reporting 
button. A message appears that asks you to confirm your request. Click the OK button.
The report is stored in BCM/Program Files/Nortel Networks/Voice Button/System.
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Monitoring active calls
You can monitor active Multimedia Call Center calls.

To monitor active calls

1 Point your web browser to the URL
https://bcm.<domain>:
where <domain> is the domain name of Business Communications Manager.
The Business Communications Manager Unified Manager screen appears.

2 Click the Configure button.
The Login screen appears.

3 In the User ID box type your user ID.

4 In the Password box type your password.

5 Click the Login button.
The Unified Manager screen appears.

6 Click the Services key.

7 Click the Multimedia Call Center heading.
The Summary screen appears.

8 On the Tools menu click Multimedia Call Center Admin.
The Enter Network Password dialog box appears.

9 In the User Name box type your user name.
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10 In the Password box type your password.

11 Click the OK button.
The System Administration page appears.

12 Under the Reporting heading, click the Active Calls button.
A report of all the currently active Multimedia Call Center calls appears in a separate window.
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Viewing log files
Log files are automatically generated daily by Multimedia Call Center. You can use log files to 
diagnose system problems. The log files include all activity that occurs with its CGI interface and 
its telephony server.

On days with no Multimedia Call Center activity, CGI log files are not generated, and blank mslog 
and vwlog files are generated.

Multimedia Call Center Log files are generated in C:\Program Files\Nortel Networks\Voice 
Button\logs.

The logs are named:

• cgilog_YYYY_MM_DD.txt: log file of CGI activity

• nslog_YYYY_MM_DD.txt: log file of NSACD service

• vwlog_YYYY_MM_DD.txt: log file of VBServer service

where YYYY is a 4-digit year
MM is a 1- or 2-digit month
DD is a 1- or 2-digit day

The Call Center log file is generated in D:\st\stlog.out.

To view a log file

1 Point your web browser to the URL
https://bcm.<domain>:
where <domain> is the domain name of Business Communications Manager.
The Business Communications Manager Unified Manager screen appears.

2 Click the Configure button.
The Login screen appears.

3 In the User ID box type your user ID.

4 In the Password box type your password.

5 Click the Login button.
The Unified Manager screen appears.

6 Click the Services key.
Multimedia Call Center Set Up and Operation Guide



72    Chapter 5  Viewing reports, active calls and log files
7 Click the Multimedia Call Center heading.
The Summary screen appears.

8 On the Tools menu click Multimedia Call Center Admin.
The Enter Network Password dialog box appears.

9 In the User Name box type your user name.

10 In the Password box type your password.

11 Click the OK button.
The System Administration page appears.
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12 Click the Examine Logs button.
The Examine Logs screen appears.

13 Select the log file you want to view:

• Click the view log button to view the log you select.

• Click the analyze log button to see a summary for the log you select.

14 If you want to archive the log and reset the statistics, click the archive reporting button.
A message appears that asks you to confirm the reset.

15 Click the OK button.
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